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Introduction 
My first experience with a venture contest was an invitation to 

judge the University of Oregon’s national venture contest in 1997.  I 
accepted the offer quickly.  I was shocked when I arrived and 
discovered I’d committed most of Thursday, all of Friday, and most 
of Saturday.  I run a company.  I didn’t think I had that much time 
available.  By Saturday, however, I was delighted, glad to have 
participated, and already offering to do it again.  Since then I’ve 
judged over a dozen national venture contests, including the most 
recent one at the University of Notre Dame and those sponsored by 
own my company, Palo Alto Software, Inc.  I’ve also spoken to 
contestants at Harvard and U.C. Berkeley about how to develop the 
plans they submit.  

Venture contests became very popular nationally in the latter 
half of the 1990s. They started at graduate business schools, and in 
the beginning most of them required MBA participation, but lately 
the idea has spread to businesses involved in entrepreneuring, 
websites, and other organizations.   

Many of these venture contests offer significant cash prizes: 
$25,000 for first place is not unusual, and I’ve been a judge for 
contests offering $100,000 to first-place finishers, and up to $3 
million in total prize money.   

This white paper is for entrants in both venture competitions 
and business plan competitions.  It’s about the competitions 
themselves, how to win them, and, specifically, how to use 
Business Plan Pro® to do it.  

Plan Contests vs. Venture Contests 
Venture competitions are more common and more fashionable 

than business plan competitions.  These competitions evaluate the 
venture’s chances for success based on factors such as market, 
competitive advantage, financing, and management team.  They 
should always include presentations for judges, and question-and-
answer (Q&A) sessions.  While plans are used for screening 
entrants, the presentations are usually even more important. 
Judges use presentations and Q&A responses to evaluate the 
management team, a critical factor.  It takes an excellent plan to get 
into the final rounds, and an excellent presentation to win.  

A business plan competition, on the other hand, is based on the 
document itself.  Judges use the plan as the summary of the entire 
venture–the same factors perhaps as the venture contest, but the 
judgment is based on the document alone.  There is no 
presentation.  
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In either case, the plan is a critical component.  It frequently 
serves as the only criteria for selection of semi-finalists and even 
finalists.  Competitions normally receive far more entrants than 
they can practically screen any other way, so the business plan is 
the critical document.  Some competitions use less than a business 
plan, just a summary document, to screen entrants; but even in this 
format the full business plan screens the finalists.   

Judging Criteria are Often Vague 
What is a good venture?  It depends on who you ask.  This is 

unfortunately a generalized problem with venture competitions, at 
least from what I’ve seen.  There is a huge range of different views 
on what’s a good venture.  For example:  

• What’s better; a $5 million opportunity with a 50% chance of 
survival, or a $50 million opportunity with a 5% chance?  

• Is a business likely to attract venture capital more worthy 
than one that doesn’t need venture capital? 

• Is a well-conceived low-risk toy manufacturing business, 
using readily-available plastic parts, more interesting than a 
very-high-tech telecommunications product that might take 
years to develop?  

Competition organizers have trouble establishing predictable 
criteria at the start.  Furthermore, judges, who tend to have venture 
capital backgrounds, tend to apply their own criteria in the moment 
of truth.  Investors almost always vote for the venture that presents 
the best investment.  They can’t help it.  

“You can’t control the backgrounds of your judges 
but if you have the chance, find out all you can about 
your judges before the competition.  Knowing their 
backgrounds will help you predict some of their 
questions and allow you to be prepared for a focus on 
one or another specific area of your plan.” 

-- Sadie Dressekie (Business Plan Contest winner) 

Optimizing Your Tools 
Be careful with this point.  Some very credible experts believe all 

business plan software is bad, presumably because some of it is bad. 
Some business plan software products are little more than shallow 
cookie-cutter boilerplate managers, with weak financials and poor 
text, and little or no flexibility.   

Business Plan Pro, however, isn’t one of those bad products.  It’s 
an effective tool that has helped the winners of several major 
contests.  It can help you.  
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Several Visible Successes 

Plans developed with Business Plan Pro have been very 
successful in national business plan competitions.  For example, 
the NovOculi business plan won first place in one national 
competition and second in two others, for a total of $40,000 in 
prize money; and it was developed using Business Plan Pro.  It’s 
included in the sample plans available with the software (look in 
the Sample Plan Browser for “Medical Equipment Manufacturer 
– Eye”).  Those sample plans (the 400+ included with the 
product) include several other contest winners, and several 
second and third place plans as well. Hands On! the Children’s 
Art Museum of Chicago, won $25,000 for its plan written in 
Business Plan Pro (look for “Nonprofit – Museum – Art 
School”).  Some others that aren’t included–Partscope, for 
example, which won the $25,000 in the University of Notre 
Dame 2001 venture contest–were also developed in Business 
Plan Pro.  

Some Important Assumptions 

Why isn’t Business Plan Pro enough by itself?  Hasn’t it been 
used to win more than $100,000 worth of venture contest prizes?   
Why is there a need for this white paper?   

1. The venture contest entry is a special-use business plan, 
one in which sophisticated formatting is likely to be an 
advantage.  

2. Business Plan Pro is designed for more standard uses.  In 
the real world a business plan is a business document, 
and a standard, professional, easy-to-read format is ideal.  
In a venture contest, however, judges use whatever 
means they have to differentiate between plans.  All other 
things being equal, the document itself could be a factor.  
Quality of ideas and content can be confused by 
sophistication of graphics and format.  When in doubt, as 
a contestant, you want to optimize your chance with the 
best possible document.  Therefore, additional 
sophistication might be useful.  

3. The ideal is to work with Business Plan Pro to give you a 
powerful tool for developing the core elements of a plan, 
and then, if necessary, export to other applications for 
finishing and formatting.   

This white paper is about optimizing, working with Business 
Plan Pro for its advantages, and then exporting for more final-
document power.  It won’t tell you the basics of using Business Plan 
Pro–you can find that information in the help sections and manual.  
What it will do is show you how to customize and improve the 
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output you create in Business Plan Pro to meet the sophisticated 
needs of a venture contest entrant. 

Best of Both Worlds 

Develop your plan with Business Plan Pro first, and then finish 
it with Word, Excel, and PowerPoint.  That gives you the assurance 
of the planning tool with the flexibility and power of the MS Office 
applications for final output.   

With Business Plan Pro you get:  

•  A strong head start with the document.  A good 
beginning outline, lots of ideas and examples.  

• Robust, mathematically and financially correct 
financials.  You’ll get a set of key tables that link 
assumptions, sales, personnel, profit & loss, cash flow, 
balance sheet, and ratios, so that any change in one 
affects all the others.  You may be able to do this yourself 
in Excel, but why bother?  What’s in Business Plan Pro is 
already linked, error tested, and documented, and it 
works.  Cash flow is sensitive to critical assumptions for 
collection days and inventory, as it should be.  Ratios and 
industry standards are already in the spreadsheet.  And 
you can export that to an Excel workbook with tables 
separated into worksheets, and with range names and 
formulas accessible.   

• A useful draft document with text, tables, and charts 
already merged on the page.  

From there you can move into Word, Excel, and PowerPoint for 
molding and polishing a final document with excellent graphics, 
formatting, charts, etc.  

“Our team began writing the plan using a template 
created in Word and we got very frustrated with the 
lack of direction.  We transferred the whole plan into 
Business Plan Pro and it gave us the outline and 
structure we needed to let us focus on the content 
rather than focusing on the format.  When we had 
completed the content in Business Plan Pro we 
exported it back into Word to fine tune the formatting.  
The planning software saved us many hours, and our 
sanity!” 

-- Sadie Dressekie 

Working in Text 
The text in a business plan should be focused and on target.  It’s 

not about great description or beautiful construction; it’s about 
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business.  Keep it simple.  Keep it short.  Use bullet points and 
numbered lists wherever you can.   

Don’t ever let your reader become distracted by how you say it.  
A plan is about what you say, not how.  And it’s more about what 
you’re going to do than what you say.  Remember, though, that 
spelling errors, run-on sentences, and poor grammar can have a 
negative impact.  Many readers object to this kind of error.  Judges 
will mark you down for it.  Don’t let it hurt your chances.  

Recommended Strategy: Stay Simple, Build, then Format 
Keep the formatting simple, stay with the standard, and focus 

entirely on content.  The outline structure, instructions, examples, 
and all of the built-in content in Business Plan Pro will help you 
clarify your thoughts and include your most important information 
during the development stage.  Don’t fuss with format until after 
the content is entered.   

Text Formatting Stage One: Simple Really Means Simple 

Once your content is entered, Business Plan Pro can deal with 
some fairly slick formatting features.  Specifically: 

• Write your text in simple paragraphs.   

• Use a San-Serif font (e.g. Arial, Verdana, Tahoma) for 
headings. These styles have a clean look that works well for 
titles.  

• Use a Serif font (e.g. Times Roman, Book Antiqua, 
Garamond, Palatino) for the standard text.  This style is 
more rounded and easier to read large blocks of text. 

• Avoid changing fonts within paragraphs.  You can use Bold 
and Italic and Underline within Business Plan Pro, but these 
too are often overused.  

• Use the bullets and numbered list facilities within Business 
Plan Pro.  Bulleted and numbered lists are practical for 
business plans; they get to the point quickly.  Insert graphic 
images or create text tables to further emphasize your text.   

The following sample shows a topic with graphic in Business Plan Pro: 
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Sample Topic with Graphics in Business Plan Pro 
 

2.1.3  Target Market Analysis 
The three main target markets for the retail operation are weekend warriors, hard 

core climbers, and the curious. Market trends are positive for this concept. The three 
major trends that should increase the size of the target market are: 

• The sport of rock climbing is enjoying growth. The successes of rock climbing 
gyms in the Silicon Valley, Seattle, Eugene, and other locations offers clear 
evidence of this increasing popularity.  

• Gourmet coffee demand is very strong throughout the Northwest. Growing 
numbers of consumers view an expensive espresso drink as a way to savor a 
moment and as a natural part of an outing or activity. 

The following shows an example of one of our ads: 

 

 

The target market forecast data is provided in the table below: 

 

 

 

Target Market Analysis
Market Segments Hard-core Weekend Warrior Curious Healthy Wealthy
Retail Consumers 5 4 3 1 3
Internet Consumers 4 4 3 2 3
Direct Mail Consumers 4 2 2 0 0
Customers from Busines 2 4 5 2 2
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Working the Numbers 
Every business plan depends on words and numbers, so 

spreadsheets are essential, and even more so for a venture contest.  
Good solid financials are critical.   

Like the plan itself, your financials can’t win a competition for 
you, but they can lose it.  Some judges will comb the numbers 
looking for obvious errors.  Some will ask you about financials 
during presentations and question-and-answer sessions, probing to 
see how well you know your assumptions, and, through that, how 
well you know the business.  

This is one of the strongest reasons for incorporating Business 
Plan Pro into the development process.  It has strong financials, 
built around correct cash flow and related financial analysis.  

Of course it is also true that every competent graduate business 
student should be able to develop complete financials using his or 
her own spreadsheet, from scratch.  Business Plan Pro won’t do 
anything that the competent MBA student shouldn’t be able to do.  
The questions are, of course, how much time is involved?  Is this a 
good place to invest dozens, possibly hundreds, of hours?  Or are 
you better off using a tool for the mechanics, and focusing on the 
content of the plan?  

“If you are writing your plan in a team you should 
assign one person to act as the CFO – one person who 
knows the numbers back to front and inside out.  Your 
CFO should have logical explanations for all the 
financial assumptions in your plan, and should 
explain them to the rest of the team over and over 
before the event.  

 This exercise will serve two purposes – it will 
ensure that the rest of the team members have a good 
understanding for the numbers and it will help you 
locate and fix errors.  If there are mistakes in your 
numbers, you can be guaranteed that the judges will 
find them and call you on them.” 

-- Sadie Dressekie 

Understand the Financial Model 
Chapter 6 of the Business Plan Pro manual explains the 

financials in detail.  That includes how tables are linked, which 
tables are linked, important formulas, options, and table details.  
This is fundamental to understanding what’s going on.  

Tables don’t stand alone.  They work together.  Your sales 
forecast and personnel plan go directly into your profit and loss, 
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and both of those, plus the balance sheet, affect your cash flow.  
Ratios come from several statements, and assumptions affect 
several too.  

Adding Additional Worksheets 
You can add worksheets in Business Plan Pro PREMIER.  

Instructions are in the Business Plan Pro manual.  You can add as 
many worksheets as you want, name them, and program them 
using standard Excel-compatible formulas. 

“Before you begin your numbers, read the rules.  
Different competitions will demand different levels of 
detail in their plans.  One may ask for one year of 
financial monthly and the next two years annually.  
Another may ask for all three years broken down 
monthly.  It won’t look good to judges if you don’t give 
them even the basics of what they have asked for.” 

-- Sadie Dressekie 

Reality Check 
No spreadsheet, no authored financial analysis, is perfect.  Every 

one of these tools depends on assumptions, algorithms to predict 
key items, and human judgment.  Business Plan Pro does this well, 
and has the advantage of a lot of testing, and the more important 
advantage of supported documentation–in a 350-page manual, 
online help, instructions and examples, row-by-row help, and links 
directly from the software to the manual and business planning 
book.  

However, although this is a huge advantage, it is still a 
spreadsheet system, a series of spreadsheet tables linked together.  
The critical balances for receivables, payables, and inventory 
depend on algorithms implemented in spreadsheets.    

Even a spreadsheet system as rigorously tested as the Business 
Plan Pro financial tables is full of potential errors for inexperienced 
users.  Delete a row, change a range name, change a formula and 
you can undermine the whole system.  Business Plan Pro can 
prevent such errors from within the application, but if you export to 
Excel, there is no protection.  

As soon as your financials are exported to Excel, they are yours 
to work with.  They can’t go back into Business Plan Pro.  
Furthermore, changes you make become your responsibility, yours 
to understand and support.  For better or worse, it’s your model, 
your programming, and, when problems come up, they’re your 
problems.  
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To Export, or not to Export?  

Strategy 1: Don’t Export 
Don’t let the discussion of exporting files put you off.  You may 

not have to export at all.  Many venture plan winners have stuck 
with the original Business Plan Pro outline and financials.  You 
don’t have to export to have excellent financials and professional-
looking formatting.   

One good look for a plan is to include the charts in the 
document, to illustrate the highlights, and leave the detailed 
financials for printing in small print, landscape instead of portrait 
mode, in appendices.  Business Plan Pro will be fine with that 
option, without requiring export to Excel or further modifications.  

You can also change the look and the feel of the financials, if you 
want, without exporting to Excel and risking a lot of problems.  Use 
the Business Plan Pro report writer (in the File > Print menu) or 
print directly from tables, using your print options.   

Strategy 2: Use the Word Interactive Feature 
You can export to Word and maintain a direct connection 

between Word and Business Plan Pro, refreshing the data in both 
applications.  Business Plan Pro adds a specialized business plan 
menu to Word.  You can work in Word without losing the facility to 
refresh table data from Business Plan Pro.  This is a 2004 version 
feature only, and is referenced below and explained in detail in 
Business Plan Pro Help.  

Strategy 3: Export for Cosmetics Only 
When you export from Business Plan Pro to Word or Excel, you 

can do some things with Word and Excel that you couldn’t do in 
Business Plan Pro, and without modifying any financials.   

Strategy 4: Export and Develop 
Some business plans and some business plan contests lend 

themselves to additional Excel work.  You might want more detail 
in one place or another, more months to show a ramp-up.  You 
might want to produce a Sources and Uses of Cash statement, 
which Business Plan Pro can’t do–although it provides you with all 
the information you need–because it doesn’t know ahead of time 
which are sources, which are uses.  

Even for this case you are still much better off with the product 
and the export from it, because you start out with a proven, tested, 
well documented workbook that works.   
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Always Keep your Business Plan Pro Files as Backup 
If you choose to export to Word or Excel, keep your business 

plan files intact.  You can lose files in any format, on any computer.  
You may make changes that you decide later to scrap.  You might 
also want to go back to Business Plan Pro for a number of other 
reasons, to redevelop the plan, to collaborate with other partners, to 
create an Adobe PDF file for transport via email. 

Export to Word  
Hold on as Long as Possible 

The key to success with this strategy is holding on within 
Business Plan Pro as long as possible before choosing to export to 
Word.  Once you’ve exported to Word, you can’t go back into 
Business Plan Pro easily.  So don’t take that step until you’re 
comfortable you’ve used the development tools within Business 
Plan Pro–the outline, instructions, examples, and related features–
as much as possible.  

Export shouldn’t be hard to do or hard to find.  It’s covered in 
detail in the Business Plan Pro manual, Chapter 9, Working with 
Microsoft Office.  

Set Your Print Options First 

The first step is checking your print Options. Select the File > 
Print command, then select the Plan option for what to print, and 
then the Options command on the print form. The Printing Options 
Dialog shown in Figure 1 makes a significant difference.  The 
exported plan will include whatever is checked in the options.  

Figure 1: Printing Options Set Export Options 
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To access the print options you need to go to the print menu and 
choose to print the plan.  That opens a dialog that includes the Print 
options shown in Figure 1.  Set your options before you go to export.  

You can experiment with the options to see what you like, but 
we generally recommend what you see in the illustration. Here’s 
why: 

• The Table of Contents works well in Business Plan Pro, and 
also with Word when you have both open.  

• The standard Legal Page isn’t appropriate for a venture 
contest.  If you do want a legal page, check with a faculty 
advisor or attorney.  Do your own in Word.  

• The Cover Page isn’t appropriate for a venture contest either.  
Design a nicer cover than what’s standard in Business Plan 
Pro.  Use a graphics application designed for that use.  

• The appendix produces detailed monthly tables suitable for 
printing in landscape mode.  You’ll end up doing the same in 
Excel after export.  

• The imbedded tables and charts are convenient.  They will be 
exported into the Word document as graphics for the charts 
and Word built-in tables, with data already entered, for the 
tables.  Although you may end up replacing these with Excel 
output pasted into the document instead, they are 
convenient where they are as placeholders.  Furthermore, 
you may decide not to replace all of them, they do look very 
good within the document.  

The Export Process in Detail 

When you choose the Plan option in the Export menu, Business 
Plan Pro is going to export the document as defined by your print 
options.  Figure 2 shows you the Export command on the File 
menu.  
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Figure 2: The File Export Command 

 

The Export command brings up the Export Wizard as shown below in Figure 3.  

Figure 3: Plan Export Wizard 

 

The text of the plan will export into one of several possible file 
formats:  

• The Business Plan Pro Word Document exports to the native 
format for Microsoft Word.  The exported file will also 
include the formatted text and imbedded tables and charts as 
well, if you set your print options correctly.  Tables will be 
included as data in Word tables, without the underlying 
calculations.  Microsoft Word will open this DOC file for 
further editing.  If you are careful and you don’t have 
unusual Word add-ons or an early version of Word, you can 
continue to work in Word and Business Plan Pro both, at the 
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same time, making changes in Word that will be absorbed in 
Business Plan Pro.  

• The Microsoft Excel Workbook is a complete workbook with 
every table in a separate worksheet.  We discuss that in detail 
below, in the section titled “Export to Excel.” 

• The Adobe Acrobat Document in (PDF) format will be a 
computer-readable file you can email as an attachment.  You 
can take it to a copy shop for reproduction there, and on a 
computer you can open it to read on the monitor or print it 
for reading on paper.  However, a PDF file is not suitable for 
further editing.  

• The Rich Text Formatted Document (RTF) is a general word 
processing text file format.  Word, Works, Word Perfect, 
WordPro, and most commercial word processing software 
will read RTF and give you the same format you see in the 
printed Business Plan Pro output.  The exported file will have 
tables and charts included if you specify that in the options.  

• The HTML Web Page export creates a file suitable for 
posting onto a website.  Illustrations create graphic files and 
tables are imbedded in HTML table style. The page will 
include the complete plan. 

• The export Plan Component creates a subset of a business 
plan that can be imported by Business Plan Pro into a new 
plan or a different plan, provided that both plans are 
developed in Business Plan Pro.  Experts use this to create 
modules for specific plan uses, vertical markets, etc. 

Tips for Working in Word after Export 
Microsoft Word is a very powerful word processor, the market 

favorite, and a de-facto standard.  If you aren’t aware of its powerful 
document features, you will want to watch for the following power 
tools for finishing your plan:  

1. You can hold your business plan open in both Word and 
Business Plan Pro so that you can work in Word and 
refresh your Word document with tables from Business 
Plan Pro.  Both applications must be open.  Business Plan 
Pro will add a “Palo Alto Software” menu in Word.  That 
menu gives you useful options for refreshing your 
Business Plan Tables within your Word file. 

2. Familiarize yourself with Word’s styles and how to use 
them.  Business Plan Pro documents have three levels of 
outline headings and three basic text styles.  Business 
Plan Pro integrates styles into the document.  
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3. In the interactive mode you can also use the Word 
Outline view.  Outline view can be set to view just the 
headings paragraphs, so you can streamline your outline 
and scan the underlying logic.  

4. Word is more powerful than Business Plan Pro for 
pasting graphic images and tables.  Although Word has 
its own table manager built in, tables are particularly 
powerful when copied from Excel with the “Copy Picture” 
command and pasted into Word as images.  The 
disadvantage of that choice, however, is that tables pasted 
as pictures will need to be modified when you change 
your numbers, because they don’t work interchangeably 
with both Word and Business Plan Pro.  See the Export to 
Excel below for instructions on using the Copy Picture 
option in Excel. 

Export to Excel 

Excel is Infinity 
Excel is an applications programming language, not a program. 

Be sure you understand the language before you attempt to make 
changes to the Business Plan Pro financial statements within Excel.  
You have the power to modify, revise, add, subtract … and break the 
financials.   

Hold on as Long as Possible 
Remember, once files are exported to Excel, they can’t be 

brought back into Business Plan Pro.  Changes you make after 
export won’t show up when and if you decide to bring the plan back 
to original form.  Your export to a plan document has the last 
numbers done within Business Plan Pro, not whatever you did 
outside of it.   

Export Process Details 
You can export from Business Plan Pro to a complete Excel 

workbook.   

The documentation on export to Excel is included in your 
Business Plan Pro manual as part of Chapter 9, Working with 
Microsoft Office.  

To export from Business Plan Pro to an Excel workbook: 

1. Execute the Export command in the File menu, then 
choose Microsoft Excel Workbook in the Export Wizard.  
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2. Use your file navigation dialog to export the workbook as 
an *.XLS file in whichever directory or folder you want.  
Remember where you left that file.  

3. Open your Excel, open the exported file, and save it 
immediately in the latest Excel file format available, with 
a different file name.  This is good discipline; it keeps a 
copy of the file as it was when exported, as a second 
(along with the original source file in Business Plan Pro) 
back-up file.  

4. Go immediately to the Tools menu in Excel, find the 
Options form, and set Sheet Tabs to show.  Without sheet 
tabs you won’t see the different worksheets included.  

5. Save again.  

Working in Excel after Export 
1. Immediately after export, all the worksheets will be 

protected, but without passwords.  You can turn 
protection off using the Excel command for that, without 
needing a password.  

2. Don’t delete anything in the workbook.  Don’t delete any 
worksheets, range names, rows, or columns.  

3. You can hide whole worksheets, rows, blocks of rows, 
columns, and blocks of columns.  Learn how to use the 
Format menu to hide what you don’t want.  

4. Each table has its own worksheet.  Look at the sheet tab 
names to find the table you want.  Make sure Excel is set 
to show sheet tabs.  

5. Some worksheets have multiple options for the specified 
table built into them, so they can switch options 
according to business plan needs.  The Personnel Plan, 
for example, has four different personnel table structures, 
one below the other.  Find the one that was assigned to 
your plan by the Business Plan Pro EasyPlan Wizard.  

6. The Profit and Loss table hides rows to switch from the 
expense categories format to the simple list format.  You 
can unhide rows to show the full table.  

7. The worksheets have a lot of logistical information in 
them, used by Business Plan Pro to manage options, 
charts, and other application functions.  Don’t delete 
these areas, ignore them.  Use the Hide commands to 
hide them if you don’t like them.  

8. You can add as many new worksheets as you want.  
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9. When creating a chart, it’s better to put the new chart 
into a new worksheet instead of on one of the existing 
worksheets.  

Using Excel’s Copy Picture Command for Graphics in Text 

Select an area in an Excel worksheet, presumably an area that 
represents a table you’d like in the main text.  Hold the shift key 
down as you open the Excel Edit menu and you’ll see the Copy 
Picture command.  Click on your Word document and paste the 
picture into it as a graphic.  

Using Excel Graphics 

Business graphics are by far the best way to communicate 
numbers in a business plan.  Business Plan Pro includes more than 
a dozen automatically produced charts, but Excel offers a very 
powerful graphics facility to build many different illustrations of 
your numbers, and more is often better.  

To use Excel graphics in your business plan, export the 
workbook and go from there.  You will have to depend on your own 
Excel knowledge, because additional charts are not part of the 
Business Plan Pro product; but the power is there for you. 

Take Your Best Shot 

The Plan Document 
• Don’t use a business plan to show off your knowledge.  It 

isn’t a PhD thesis.  Your judges will have at least five 
business plans to read.  They won’t appreciate anything extra 
that doesn’t add interest or reduce confusion.  

• Don’t allow spelling or grammatical errors.  Don’t trust your 
spell checker.  Don’t trust your grammar checker.  Read the 
plan.  Have others read it.  Spell checkers would accept “Yule 
bee sorry if ewe leaf yore plan to tulles like that won.” 
Business plan judges won’t.  

• Save some white space.  Don’t get around a page limitation 
by cramming your plan into tiny fonts and tight spacing.  Cut 
the word count, not the readability.  

Presentations and Events 
The PowerPoint Presentation File 

Plan to have an excellent presentation.  Concentrate on it.  Learn 
to use PowerPoint well.  Create an excellent PowerPoint 
presentation and deliver it well.   
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• Keep it simple, logical, organized, and interesting. 

• Be careful with sound and animation; don’t overuse the 
tricks.  Don’t distract your audience with it.  

• Build it logically, covering all the main points, in the right 
order.  

• Don’t get lost in details.  

• Avoid too much text on the slides.  They are placeholders, 
reminders only.   

• Use large text, and simple easy-to-read charts.  If you can’t 
display it with 24 point fonts or larger, it’s too much text.  

• Avoid trivial, distracting clip art.  

Be sure to check out the Business Plan Pro manual for 
additional details about developing PowerPoint presentations from 
your business plan. There’s a section on the PowerPoint 
presentation in Chapter 8, Print and Publish.  That section includes 
some general presentation tips.  There’s another section on working 
with PowerPoint in Chapter 9, Working with Microsoft Office, that 
offers more details on export and file templates.  

Delivering the Presentation 

If you aren’t already comfortable with presentation styles and 
the basics of good delivery, get some training, go over magazine or 
Web articles on presentations, get some help.  Judges in venture 
competitions pay a lot of attention to your presentation delivery.  

Your faculty advisor should be your first resource.  Business 
school professors are usually good presenters, they recognize the 
importance of presentation technique, and can point you to 
additional trainings and readings.  You can also get a lot with a 
quick search on the Internet.  For example, take a look at what you 
get in Google (www.google.com) with the search for “presentation 
skills.” Try Yahoo! (www.yahoo.com) with that same search term.  
You can also look for books on presentation skills at one of the 
larger local bookstores or of course online at www.amazon.com or 
at www.barnesandnoble.com.  

Focus on the people listening, their response to you, rather than 
the PowerPoint presentation itself.  Never read bullet points, avoid 
as much as possible direct reference to anything in the presentation 
except pictures and business charts.  Try to keep your audience 
focused on your face, not your slides.  Don’t “learn” every word of 
your presentation.  It will come off as rehearsed and not believable.  
Do not read from cards or notes.  If you have to read your 
presentation and refer to notes, do you really know your business? 
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“At the end of the day a competition is a learning 
experience, so don’t be afraid to take chances and 
make mistakes.  Judges will know that most of your 
team members are students – they will know your 
limitations, and you should too.  Don’t be afraid to 
admit that your management team needs more 
experience than you have available.” 

-- Sadie Dressekie 

 

Dealing with Questions, and Possibly Interruptions 

I was in a judges’ meeting at a venture contest–I won’t say which 
one here–in which the judges changed the rules an hour before the 
presentations started.  The finals had been set to give each team 20 
minutes of presentation followed by 20 minutes of question and 
answer.  The judges, however, decided that interruptions are part of 
real business presentations, so contestants should have to deal with 
interruptions immediately, without the 20 minutes grace period.  

That last-minute change made for a better contest.  It was 
tougher for the teams, but more realistic.   

The way that you answer questions can be very important, 
sometimes even more so than the content of your answers.  Beware 
of extremes:  

• The extreme submissive strategy, thanking people for their 
objections and promising to take them into consideration, 
doesn’t usually work.   

• The extreme defensive strategy, defending every point to the 
death despite all logic and reason, doesn’t work either.  

• The extreme aggressive strategy, arguing with the judges, 
doesn’t work.  

It’s hard to prepare for the tough questions, because if you were 
able to predict them you’d have built the answers into your plan and 
presentation.  Strive for a middle ground, between the extremes, 
that respects the judges and honors the truth.  When in doubt, look 
for the truth in the points of view, and follow the truth to the right 
answer.  Sometimes judges’ objections will be the most valuable 
lesson you’ll learn in the contest.  Sometimes it’s important to not 
give in too quickly.  There’s a “know when to hold ‘em, know when 
to fold ‘em” factor with answers that’s hard to generalize.  
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“The best way to prepare for the Q&A section is 
practice.  Ask your friends, colleagues and professors 
to watch your presentation and ask you questions 
afterwards.  Make sure that they know you want them 
to be as tough and critical as possible in their 
questioning.  It will prepare you for the toughest most 
critical judges. 

Because it’s not “real life,” don’t be overconfident.  
Many of the judges are venture capitalists and 
business people who make multi-million dollar deals 
as often as you turn in term papers, so your humility 
will be appreciated.” 

-- Sadie Dressekie 

Get the Most Out of It 
I’ve enjoyed these contests immensely.  They deal with a 

fascinating realm of new ideas and possibilities, in a way that 
should start out as fun and get better from there.   

Please don’t waste the opportunity.  If you can’t see how 
developing a business plan is like creating a new world, making 
something out of nothing, then you’ll miss all the fun.  If you can’t 
take the exchange with judges as a risk-free wild ride into the 
future, then you’ll miss that too.  Most of these competitions have 
judges whose status and success in entrepreneuring makes them 
very hard to reach through normal channels.  Enjoy your access 
while you have it, and take their criticism as very valuable advice.  

It’s an amazing opportunity to put yourself and your ideas in 
front of people who have enormous value to add, and at no cost to 
you except effort.  Take advantage of it.  

 Tim Berry 
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